Content Manager’s Guide to Ingeniux CMS

I. Accessibility.................................................................................................................................................2

II. Logging in and Locating Your Pages/Components.........................................................................................2

III. Editing Page Content and Components......................................................................................................4
    Workflow.........................................................................................................................................................4
    Titles & Text ................................................................................................................................................6,7
    Links .............................................................................................................................................................7
    Images ..........................................................................................................................................................11
    YouTube Videos ........................................................................................................................................13
    Components ................................................................................................................................................15
    Mastheads ...................................................................................................................................................16
    News Pages & Feeds ................................................................................................................................20

IV. Deleting, Unpublishing & Placing on Hold.....................................................................................................22

V. Creating New Items .......................................................................................................................................24

VI. Adding/Editing Assets ..................................................................................................................................24

VII. Appendices ..................................................................................................................................................25
    A. Image Size Requirements & Sizing Tools .................................................................................................25
    B. Heading Samples .....................................................................................................................................30
    C. Accessibility Solutions (Complete List) ..................................................................................................30

QUESTIONS? SUBMIT A HELP TICKET

Send your CMS questions and help requests to cmshelp@duq.edu or submit a ticket at www.duq.edu/cmstickets.

If you are having problems related to your browser or computer, contact the CTS Help Desk at help@duq.edu.
I. ACCESSIBILITY

Just as with physical buildings, we make accommodations to our website so it is accessible to all users and in compliance with the Americans with Disabilities Act (ADA).

Most of those accommodations are addressed by the Marketing and Communications Web team, but the following require content managers’ attention:

- Images
- Page Titles
- Headings
- Link Text
- Abbreviations/Acronyms
- Video/Audio Text Alternatives

Accessibility solutions for each of these items are addressed in respective sections below and denoted with a magnifying glass:

คำถามAccessibility Requirement

All accessibility solutions are also collected in the Accessibility Solutions (Complete List) appendix for quick reference.

II. LOGGING IN AND LOCATING YOUR PAGES AND COMPONENTS

Logging in

1. To log into the content management system (CMS), go to duq.edu/cms.
2. Log in with your Multipass username and password.
Locating Pages and Components

1. Locate the CMS site tree:

![CMS Site Tree]

2. To navigate the site tree in the CMS, click the plus icon next to each page/component. (Plus icons become minus icons after they are clicked. Click a minus icon to collapse the section again.)

TIP! For the most part, the CMS site tree is an exact copy of navigation on the live site. This means the breadcrumbs at the top of a live page can help you identify where you will find that same page in the CMS:

![Live Page Breadcrumbs vs. CMS Site Tree]
III. EDITING PAGE CONTENT AND COMPONENTS

**TIP!** You can only edit the pages that you have permission to access. If you need to gain access to additional pages, submit a request to cmshelp@duq.edu.

**Advancing in Workflow to Access and Publish Pages**

To edit a page or component, click on it in the CMS site tree and then follow the workflow steps below:

1. Click the Advance in Workflow button in the top CMS navigation and choose **Edit content**.

2. When the Advance Page In Workflow box appears, the Allowed Transitions field will be pre-populated with **Edit content**. Click Advance.

3. A second window will open. Choose your name from the list of users and click OK.
4. The fields on the page will turn from gray to white, indicating you have access to edit the page:

![Image of page in edit mode]

To publish your edits to the website, follow the workflow steps below:

1. Click the Advance in Workflow button in the top CMS navigation and choose **Add to publishing queue**.

![Image of Advance in Workflow button]

2. When the Advance Page In Workflow box appears, the Allowed Transitions field will be pre-populated with **Add to publishing queue**. Click Advance.

![Image of Allowed Transitions field]

3. A second window will open. Choose **-- All users in the group --** from the list of users and click OK.

![Image of select user window]

4. The fields on the page will turn from white to gray, indicating you no longer have access to editing. You can return to edit mode at any time.
Editing Page Titles and Text

Page Title

1. Put your cursor in the Page Title/Heading field (near the top of the CMS page) and type your desired title.

   ![Page Title/Heading][1]
   
   Media, Marketing and Web

Accessibility Requirement

Page titles/headings should be short and indicate the page’s specific purpose or topic. Avoid generic titles like “Home,” “About,” or “Welcome.”

Text in Main Body

1. Type directly into the Content field. The field’s editing menu provides options for basic formatting.

   ![Content][2]
   
   Duquesne’s Office of Marketing and Communications directs the University’s media relations. Web communication

   **TIP!** To preview your changes, click on the Page View tab:

   ![Page View][3]

Accessibility Requirement

Abbreviations and acronyms should be defined in their first use on a page (e.g. “Free Application for Federal Student Aid (FAFSA).”) Once defined, subsequent uses of the abbreviation or acronym on same page are allowed.

Avoid using uncommon or Duquesne-specific Abbreviations and Acronyms like BSNES, Admin, “the Bluff,” and DCPSE.
**Headings**

Headings are pre-formatted styles (see Appendix B: Heading Samples) for text. They can be used to create visual hierarchy on a page and identify the main idea/purpose for a section of text.

1. Highlight the text you want to format as a Heading.
2. Select the appropriate Heading from the Format dropdown menu.

![Format dropdown menu with Heading options](image)

**Accessibility Requirement**

*Headings identify the topic for a section of text and must be used hierarchically. For example, if you use Heading 2 for a main section, use Heading 3 to identify subsections.*

*Avoid using Headings to simply add visual interest or color to a page.*

**Linking & Unlinking**

**Accessibility Requirement**

*Links must be embedded in text that identifies where the link is sending the user. Avoid using link text that shares a URL or tells the reader what to do (e.g. “click here,” “visit this page,” “download”).*

**NOT:** View our summer course catalog.
**YES:** View our [summer course catalog](#).

**NOT:** Click here to learn about accessibility guidelines.
**YES:** Learn about [accessibility guidelines](#).

**NOT:** Visit [url.dknaskfnadlaskf.com](#).
**YES:** Visit the [Intro 101 Syllabus](#).
Internal Linking

Internal links connect text to another Duquesne website page. To link internally:

1. In the Content field, highlight the words or image you are linking from.

2. In the CMS site tree, locate the page you are linking to.

3. Drag and drop that page over the highlighted text. The highlighted text will turn blue and be underlined, indicating you have created a link.

External Linking

External links connect text to a non-Duquesne website. To link externally:

1. In the Content field, highlight the words or image you are linking from.

2. Click the link icon, which will become brighter in the Content field tool bar.
3. When the Insert/edit link window pops up, click the circle next to External:

![Insert/edit link window](image)

4. Copy and paste the URL you are linking to into the URL field.

5. Click the dropdown arrow on the far right of the Target field and choose Open in new window (_blank).

6. Add a short title for your link. No more than 3-7 words, usually the title of the page to which you are linking.

7. Click Insert. The highlighted text will turn blue and be underlined, indicating you have created a link.

**Linking to a Document**

Document links connect text to a full document (typically a PDF). Documents must first be uploaded to the assets folder (see instructions for uploading Assets on page 21). Once the document is an asset:

1. In the Content field, highlight the words or image that you would like to link from.

![Content field](image)

2. Click the link icon, which will become brighter in the Content field tool bar.

3. When the Insert/edit link window pops up, click the circle next to Document.
4. Click the Browse icon next to the Document field to navigate to the appropriate assets folder and choose your document.

5. Click the dropdown arrow on the far right of the Target field and choose Open in new window (_blank).

6. Add a short title for your link. No more than 7-10 words, usually an abbreviated version of the title of the document to which you are linking.

7. Click Insert. The highlighted text will turn blue and be underlined, indicating you have created a link.

**Linking to an Email**

Email links connect text to a specific email address. To link to an email:

1. In the Content field, highlight the words or image you would to link from.

2. Click the link icon, which will become brighter in the Content field tool bar.

3. When the Insert/edit link window pops up, click the circle next to Email.
4. In the E-Mail field, enter the email address you are linking to.

5. Click the dropdown arrow on the far right of the Target field and choose Open in new window (_blank).

6. Add a short title for your link. The recommended title is Email [Full Name].

7. Click Insert. The highlighted text will turn blue and be underlined, indicating you have created a link.

**Unlinking**

Unlinking permanently removes a link. To unlink:

1. In the Content field, highlight the words or image you want to unlink.

2. Click the unlink icon , which will become brighter in the Content field tool bar. The formerly blue, underlined text will return to standard formatting.

**Embedding Images**

Images must first be uploaded to the assets folder (see instructions for uploading Assets on page 21). Once the image is an asset:
1. Put your cursor in the Content field where you would like the image to appear.

2. Click the Insert/edit image icon in the Content field tool bar, and the Insert/Edit Image window will pop up.

3. Click the Browse icon to the right of the Image URL field, navigate to the appropriate assets folder, and choose the image you want to embed.

4. Add image description.

**ACCESSIBILITY REQUIREMENT**

All images must include an image description (also called “alt text”). Image descriptions should be brief and convey a clear sense of what is pictured/happening in the image.

If an image contains words, the description should include those words.

When an image is decorative and adds no meaning to the page (e.g. a scroll or flourish), the image description field can be left empty.

5. Click Insert.
Embedding YouTube Videos

1. Go to the video on YouTube.
2. Click on the Share icon below the YouTube video.
3. Click on Embed.
4. If your page **does not** have right column components on it, YouTube’s standard video width (560x315) will work and you can proceed to step 6.
5. If your page **does** have right column components on it, do the following to re-size the video:
   a. In the code that appears when you click embed, replace 560 with 400. Then replace 315 with 225:

   `<iframe width="560" height="315" src="https://www.youtube.com/embed/"`<br>
   `<iframe width="400" height="225" src="https://www.youtube.com/embed/"`<br>

6. Highlight and copy the iframe embed code.
7. In the CMS, access your page and identify where you’re going to place the video. In that spot, type VIDEO HERE:

8. Click on the HTML icon in the Content field tool bar.
9. In HTML Source Editor window, locate the line with VIDEO HERE. Highlight the entire line as shown below and paste in the embed code you copied from YouTube.
10. Click Update.

ACCESSIBILITY REQUIREMENT

All video and audio must provide a text alternative, commonly referred to as captions (for video) or transcripts (for audio).

Video captioning must be synchronized and punctuated. Spoken words need to be properly punctuated for readability and clarity. When there are speakers on screen in a video, each must be identified by placing the caption under the speaker and the name, gender, or character must be in parentheses and on its own line separately from the caption.

YouTube is the preferred video host because it provides auto-captioning. YouTube’s auto-captions do not meet compliance standards, but this is still a useful interim measure for getting captions in place.

Remove all videos and audio that are not essential to your website, are not hosted on YouTube, and/or will not be updated to include text alternative caption or transcripts.

Do not link video or audio that does not provide a text alternative.

Editing, Adding and Removing Components

Editing Components
1. In the CMS site tree, find the page that houses the component. Scroll down to the Page Components section on that page.

2. Choose the appropriate location for the component box (left, right, sub) and expand the field by clicking on the dropdown arrow on the right.

3. Find the field with the component you’d like to edit and click the Go button. This will take you to the component.

4. In Workflow, advance the component to Edit.

5. Put your cursor on the Content field near where you would like to begin editing and make changes as needed.

Adding Components to a Page

To add an existing component to a page:

1. Scroll down to the Page Components section.

2. Choose the appropriate location for the component box (left, right, sub) and expand the field by clicking on the dropdown arrow on the right.
3. Locate the component in your department or office’s component folder. Single click and hold the desired component, then drag and drop it into the appropriate Page Components field (the field’s border will turn orange to indicate you can drop the component).

**Removing Components from a Page**

1. Scroll down to the Page Components section (see examples above).

2. Choose the appropriate location for the component box (left, right, sub) and expand the field by clicking on the dropdown arrow on the right (see examples above).

3. Click Clear.

**Changing/Adding a Static Masthead**

Content and program pages can include a static masthead at the top. Masthead images must first be uploaded to the assets folder (see instructions for uploading assets on page 21). To change or add a static masthead:

1. Click the dropdown arrow to the far right of the Masthead Options field.

2. Choose where your caption will appear by clicking the dropdown arrow to the far right of the Caption Alignment field.
**TIP!** Captions are optional. If you want no caption to appear, choose none. Do **not** leave this field blank or a gray bar will appear at the bottom of your masthead.

3. Under Masthead Image, click the Browse icon to the right of the Image URL field, navigate to the appropriate assets folder, and choose your image.

**TIP!** Masthead images must be 884x384. See Appendix A for all image size requirements.

4. If you have chosen a right- or left-aligned caption, type your header into the Caption Header field. A header will not appear above your caption if you have chosen a bottom-aligned caption even if you enter text into the Caption Header field.

5. Type your caption content into the Caption Content field.

**Changing/Adding a Masthead Slideshow**

Program pages can include a masthead slideshow (also called a rotating masthead) instead of a static masthead. Masthead images must first be uploaded to the assets folder (see instructions for uploading assets on page 21). To create a masthead slideshow:

1. Create all of your individual masthead slide components.
   a. Right click on the components folder where slides will be housed.

   **TIP!** In the CMS, components are stored separately from pages. Look for the Components folder near the top of the site tree, here:

   ![Components folder](image)

   b. Hover your mouse over New and select Component.

   ![New option](image)

   c. A pop-up will appear. Using the dropdown arrow to the right of the Select Rule field, select Masthead slide (Program Home).
d. Name the slide in the Name field.

e. Click Create. The CMS will automatically open your new slide component.

f. Choose where your caption will appear by clicking the dropdown arrow to the far right of the Caption Alignment field.

    **TIP!** Captions are optional. If you want no caption to appear, choose none. Do not leave this field blank or a gray bar will appear at the bottom of your masthead.

g. Under Masthead Image, click the Browse icon to the right of the Image field, navigate to the appropriate assets folder, and choose the image you want to feature.

    **TIP!** Masthead images must be 884x384. See page 22 for all image size requirements.

h. If you have chosen a right- or left-aligned caption, type your header into the Caption Header field. A header will not appear above your caption if you have chosen a bottom-aligned caption.

i. Type your caption into the Caption Content field.

j. Publish the component and repeat steps for as many slides as needed.

2. Once you have created all of your slides, go to the Program Home Page where you’d like to add them and advance it to edit.

3. Click the dropdown arrow on the far right of the Masthead Rotating field.
4. Add one Masthead Slide component per MastheadOptions field (also see Adding Components on page 15 if you are unsure about how to do this).

**Changing/Adding Feature Slides (School Landing Page Slideshow)**

School Landing Pages use Feature Slides rather than static or rotating mastheads. Feature Slide images must first be uploaded to the assets folder (see instructions for uploading assets on page 21).

1. Expand the Feature Slides section (and the Slides field within it) by clicking the dropdown arrows to the right.

2. Name the slide in the blank field below the SlidetItem heading.

3. Expand the SlidetItems and Caption Options fields the same way.
4. Under Slide Image, click the Browse icon to the right of the Image field, navigate to the appropriate assets folder, and choose the image you want to feature.

**TIP!** Slides must be 1408x550. See page 22 for all image size requirements.

5. Under Caption Options
   a. In the Placement dropdown, choose where you want your caption to appear.
   b. Under Caption Header, type in your caption header.
   c. Under Caption Content, type in your caption.
   d. Under More Information Link, add and name your link.

6. To add more embedded slides, click the plus button next to the SlideItem field. To remove slides, click the minus button.

**Creating News Pages and Feeds**

If it makes sense to feature recent news on your website, a News Page and coordinating News Feed component can be a good way to do it.
News Page and Feed Example:

Contact the DMC Web Team to set up a News Page for you. Once that page is created, you can populate it with news items:

1. Locate the News Page in the CMS. In the site tree, underneath the News Page, you’ll see one or more folders for News Items. Right click on the appropriate folder and create a new page.

2. Choose News/Event as the page type, and name the page after the article’s headline.

3. The News/Event page can be edited in the same manner as any content page. Add content and images as you see fit (typically the entire article is typed or pasted into the Copy area), but two required sections are unique to the News/Event page:

   a. Type of page: Select “news.”
b. News Options: Choose a publication date.

4. Advance to publish. This will populate the news item on your News Page.

If you’d like to feature the 4-6 most recent news items on your main/landing page, you can create a component box (see pg. 16) to house the headlines and link to the full items. You will be responsible for manually maintaining this component box, adding and deleting headlines as is appropriate.

IV. DELETING, UNPUBLISHING, PLACING ON HOLD

Deleting Pages

1. Right click on the page you’d like to delete and click delete.

2. A window will pop up to verify you want to delete the page. Click Delete or Cancel depending on what you’d like to do.

**TIP!** Deleted pages and components are temporarily stored in a recycle folder before being permanently deleted. If you accidentally delete a page or component, submit a help ticket immediately so the OMC web team can try to recover it for you.

Unpublishing Pages

An unpublished page or component no longer appears on the public website but is retained in the CMS site tree. You might, for example, unpublish a page related to an annual event that has just ended, with the intent of editing and re-publishing it closer to next year’s event. To Unpublish:
1. Click Advance in Workflow in the top CMS navigation and choose Unpublish (remove from site).

2. When the Advance Page In Workflow box appears, the Allowed Transitions field will be pre-populated with Unpublish (remove from site). Click Advance.

3. Assign to All Users group and click OK. The page will be removed overnight.

To recover and edit an unpublished page:
1. Click Advance in Workflow in the top CMS navigation.

2. Choose Edit content.

3. Assign to yourself.

**Placing a Page on Hold**

If you have finished editing a page but aren’t ready to publish it yet, place the page on hold.

1. Click Advance in Workflow in the top CMS navigation and choose Place on hold (not published).

2. When the Advance Page In Workflow box appears, the Allowed Transitions field will be pre-populated with Place on hold (not published). Click Advance.

3. Assign to All Users group and click OK.

To resume editing a page you placed on hold:
1. Click Advance in Workflow in the top CMS navigation and choose Edit unpublished content.

![Advance in Workflow](image)

2. When the Advance Page In Workflow box appears, the Allowed Transitions field will be pre-populated with Edit unpublished content. Click Advance.

3. Assign to yourself and click OK.

V. CREATING NEW ITEMS

Creating New Items

1. In the CMS site tree, find the page or folder that will house the new item and right click. Hover over New and then choose the kind of item (page, component, folder) you’d like to create.

![Site tree](image)

2. Choose the page or component type you’d like to create from the Select Rule dropdown menu and give it a name.

![Select Rule](image)

3. Your new page will automatically open.

VI. ADDING ASSETS

Images and documents must be added to the Assets folder before they can be used in CMS pages or components. Be sure to name your document or image prior to uploading it as an asset. To add a document or image as an asset:
1. Click on the Asset icon \[Assets\] in the top CMS navigation. A window will pop up with two folders in the left-hand pane: Documents and Images.

2. Click the plus icon \[\] next to the appropriate folder in order to locate the folder that will house your asset.

3. Once you have located the correct folder, click the Upload icon in the upper-right corner of the window.

4. Click Select File to Upload. This will give you access to your files on your computer. Navigate your folders and select the file you want to upload.

5. Click Upload in the bottom-right corner of the window.

**VII. APPENDICES**

**Appendix A: Image Size Requirements & Tools**

**SIZE REQUIREMENTS (IN PIXELS)**

- School Landing Page Masthead (large slide): 1408 x 550
- School Landing Page Highlights (three small photos below the masthead): 376 x 195
- Program or Content Page Masthead: 884 x 384
- Faculty Profile Photos: 150 x 150
- Event or News Item Photos: headshots 150 x 150, other photos – horizontal 300 x 200, vertical 400 x 600
- Photos in Right Sidebar Component: 250 x 150-325
RESIZING TOOLS

ADOBE PHOTOSHOP

1. Open Photoshop and select File > Open to navigate to the image you wish to crop. (Or you can drag the image to the canvas).

2. Select the crop tool

3. Select W x H x Resolution from the dropdown. Type the required dimensions (ex: 884 px by 384 px). Note: It is important to include px.

4. Move box as needed to crop and then hit Enter on the keyboard when ready to crop.

5. Select File > Export > Save for Web. Images should be saved as jpg and the quality should be 60 or higher. No images should be larger than 1 MB.
6. **Click Save.** Name image appropriately with subject and date (ex: fallcommencement-2021-masthead).

**MICROSOFT PAINT 3D**

1. Open Paint 3D and select **Open > Browse files** to navigate to the image you wish to crop.

2. **Select the Canvas** from the top menu.

3. **Show Canvas** is selected to **On**.

4. Enter the desired width (ex: 884 px for a masthead).

5. Make sure **Lock aspect ratio** and **Resize image with canvas** boxes are **checked**.

6. **Select Pixels** from the dropdown, if it is not already selected.
7. Select the **Crop** tool.

8. **Choose your framing** > Custom

9. Enter the **height** of image (ex: 384 px)

10. **Check Lock aspect ratio**.

11. Move box to desired location to crop.

12. Select **Done**.

13. Select **Menu** > **Save As** > **Image** > save image as 2D JPEG (ex: chapel-2021-highlight.jpg)

*SQUOOSH (free online photo sizing tool)*
TIP! Choosing correct images that are already correctly shaped—for example, if resizing a masthead photo and the original image is a rectangle, Squoosh is a good option.

1. Go to https://squoosh.app/editor and drag and drop your image in the middle of the screen.

2. Select/check “Resize” and uncheck “Maintain aspect ratio.” Set width and height (884 and 384, respectively, for mastheads).

3. Click the small blue icon in bottom right corner to save and name the file. (Choose JPEG as format.)
Appendix B: Heading Samples

Heading 1
Heading 2
Heading 3
Heading 4
Heading 5
Heading 6

Paragraph

Appendix C: Accessibility Solutions (Complete List)

Abbreviations/Acronyms

Abbreviations and acronyms should be defined in their first use on a page (e.g. "Free Application for Federal Student Aid (FAFSA).") Once defined, subsequent uses of the abbreviation or acronym on same page are allowed.

Avoid using uncommon or Duquesne-specific Abbreviations and Acronyms like BSNES, Admin, “the Bluff,” and DCPSE.

Headings

Headings identify the topic for a section of text and must be used hierarchically. For example, if you use Heading 2 for a main section, use Heading 3 to identify subsections.
Avoid using Headings to simply add visual interest or color to a page.

Images

All images must include an image description (also called “alt text”). Image descriptions should be brief and convey a clear sense of what is pictured/happening in the image.

When you insert an image into a page and component, the Image Description field will appear in the General tab, just below the Image URL:

If an image contains words, the description should include those words.

When an image is decorative and adds no meaning to the page (e.g. a scroll or flourish), the image description field can be left empty.

Link Text

Links must be embedded in text that identifies where the link is sending the user. Avoid using link text that shares a URL or tells the reader what to do (e.g. “click here,” “visit this page,” “download”).

NOT: View our summer course catalog.
YES: View our summer course catalog.

NOT: Click here to learn about accessibility guidelines.
Page Titles

Page titles/headings should be short and indicate the page’s specific purpose or topic. Avoid generic titles like “Home,” “About,” or “Welcome.”

Video/Audio Text Alternatives

All video and audio must provide a text alternative, commonly referred to as captions (for video) or transcripts (for audio).

Video captioning must be synchronized and punctuated. Spoken words need to be properly punctuated for readability and clarity. When there are speakers on screen in a video, each must be identified by placing the caption under the speaker and the name, gender, or character must be in parentheses and on its own line separately from the caption.

YouTube is the preferred video host because it provides auto-captioning. YouTube’s auto-captions do not meet compliance standards, but this is still a useful interim measure for getting captions in place.

Remove all videos and audio that are not essential to your website, are not hosted on YouTube, and/or will not be updated to include text alternative caption or transcripts.

Do not link video or audio that does not provide a text alternative.